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Here’s a microcontroller-based tem-
perature indicator that displays the
temperature in the range of –55°C

to 125°C. Besides AT89C52 microcontroller,
it uses a temperature sensor chip and an
LCD module. The indicator outputs the
calibrated data in digital form. The program
for the microcontroller is written in C and
not in Assembly language. Since C program
has well-defined syntax, it far outweighs

the merits of the Assembly
language program.

The circuit
Fig. 1 shows the block dia-
gram of the temperature in-
dicator using microcontroller
AT89C52. The power sup-
ply for the circuit is regu-
lated by IC 7805 and sup-
plied to different parts of the
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Fig. 1: Block diagram of temperature indicator using
AT89C52

Fig. 2: Circuit diagram of temperature indicator using AT89C52
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unit. DS1621 is the temperature sensor
chip. The microcontroller unit (MCU) reads
the temperature from the sensor. The tem-
perature data is compared with certain
user-defined temperature values and pro-
cessed inside the MCU as per the program
and then sent to the LCD for display.

Fig. 2 shows the circuit of tempera-
ture indicator using microcontroller
AT89C52. Working of each section of the
circuit is covered in the following para-
graphs.

Power supply. The power supply unit
consists of a step-down transformer (230V
AC primary to 0-9V, 250mA secondary),
bridge rectifier and voltage regulator. The
output of the transformer is fed to bridge
rectifier diodes D1 through D4 (each
1N4007). The ripple from the output bridge
rectifier is filtered by capacitor C1 and fed to
regulator IC 7805. The regulated output is
given to the temperature sensor,
microcontroller unit and LCD module, re-
spectively.

When switch S1 is closed, LED1 glows
to indicate the presence of power in the
system.

Temperature sensor. Temperature sen-
sor chip DS1621 (IC3) is an 8-pin DIP IC.
Its pin details are shown in Fig. 3 and the
internal block diagram in Fig. 4. The chip
can measure temperatures from –55°C to
+125°C in 0.5°C increments, which are
read as 9-bit values. It can operate off 2.7V
to 5.5V. Data is read/written via a 2-wire

serial interface.
Pins 1 and 2 of
the temperature
IC are connected
to pins 11 and 10
of the
microcontroller,
respectively.

The thermal

alarm output (T
out) of IC DS1621 activates

when the temperature exceeds user-
defined high temperature TH. The output
remains active until the temperature drops

below user-defined low temperature TL.
User-defined temperature settings are
stored in the non-volatile memory. Tem-
perature settings and temperature readings
are all communicated to/from IC DS1621
over a 2-wire serial cable. The most sig-
nificant bit (MSB) of the data is transmit-
ted first and the last significant bit (LSB)
is transmitted last.

Addressing. The chip address of
DS1621 comprises internal preset code
nibble ‘1001’ (binary) followed by exter-
nally configurable address pins/bits A2,
A1 and A0. The eighth bit of the address
byte is determined by the type of opera-
tion (either read or write) that is to be
performed. For writing to the device the
eighth bit is ‘0’ and for reading from the
device the eighth bit is ‘1.’ In our case,
A2, A1 and A0 pins are grounded and
hence the device address for writing is
‘1001000b’ or 90(hex) and for reading the
device address is ‘10010001b’ or 91(hex).

Configuration/status register. This reg-
ister can be accessed for reading or writ-
ing by issuing command byte AC(hex)
from the master (82C52). This register is
particularly required if DS1621 is used for
thermostat control, since it contains flag
bits THF (high-temperature flag) and TLF
(low-temperature flag) which are set to
‘1’ when temperature crosses the respec-
tive limits earlier written into TH and TL
registers. It also contains the flag bit
(Done), which is set to ‘1’ when results of
conversion are available after issuing of

Fig. 3: Pin details of IC
DS1621

Fig. 4: Internal block diagram of IC DS1621

PARTS LIST

Semiconductors:
IC1 - 7805 regulator IC
IC2 - AT89C52 microcontroller
IC3 - DS1621 temperature sensor
D1-D4 - 1N4007 rectifier diodes
LED1 - Red LED

Resistors (all ¼-watt, ±5% carbon,
unless stated otherwise):
R1 - 1-kilo-ohm
R2 - 47-kilo-ohm
R3 - 10-kilo-ohm
R4, R5 - 4.7-kilo-ohm
VR1 - 1-kilo-ohm preset

Capacitors:
C1 - 470µF, 25V electrolytic

capacitor
C2, C3, C4 - 0.1µF ceramic disk
C5 - 10µF, 16V electrolytic

capacitor
C6,C7 - 33pF ceramic capacitor

Miscellaneous:
Transformer - 230V AC primary to 0-9V,

250mA secondary
Crystal - 12 MHz
LCD - 16×1 LCD module
S1 - On/Off SPST switch

Fig. 5: Pin details of IC AT89C52
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start conversion command EE(hex). The
other bits of configuration register are de-
fined below:

‘NVB’ is the non-volatile memory busy
flag, ‘1’ is write to an E2 memory cell in
progress, ‘0’ indicates that non-volatile
memory is not busy, ‘POL’ is non-volatile
output polarity bit (‘1’=active-high and
‘0’=active-low) and ‘1SHOT’ is one-shot

mode. A copy to E2 may take up to 10 ms.
If 1SHOT is ‘1,’ DS1621 will perform one
temperature conversion upon reception of

the Start Convert T protocol. If
1SHOT is ‘0’, DS1621 will con-
tinuously perform temperature
conversions. This bit is non-vola-
tile.

Command Set. Complete command in-
struction set for accessing various internal
registers as well as for starting and stop-
ping of conversion process are given in
Table I. For understanding the exact se-
quence in which Start bit, address byte,

acknowledgement bit, command byte(s)
and data byte(s) are to be sent along the I2C
bus, please refer to the datasheet of DS1621,
wherein these aspects have been explained
in proper detail. This will help in under-
standing the contents of the main program.

Microcontroller unit. Microcontroller
AT89C52 (IC2) is a 40-pin IC from Atmel.
Its pin details are shown in Fig. 5. Like
AT89C51, it also belongs to the 8031/8051
family. Microcontroller AT89C52 has a
256×8-bit internal random-access memory
(RAM), eight interrupt sources and 8 kB
of flash memory compared to 128x8-bit

internal RAM, six inter-
rupt sources and 4 kB
of flash memory in
AT89C51. By combining
a versatile 8-bit CPU
with flash memory on
a monolithic chip,
Atmel AT89C52 is a
powerful, highly flexible
and cost-effective solu-
tion to many embedded
control applications.

Ports 0 and 2 are 8-
bit bidirectional input/
output (I/O) ports.
These ports haven’t
been used in this tem-
perature indicator.

Port 1 is an 8-bit bi-
directional I/O port with
internal pull-ups. Ports
1.0 through 1.7 are con-
nected to pins 7 through
14 of the LCD. Port-1
output buffers can sink/
source four TTL inputs.

Port 3 is an 8-bit bi-
directional I/O port with
internal pull-ups. Ports
3.0 and 3.1 of IC2 are

connected to serial clock line (SCL) and
serial data line (SDA) of IC3, respectively.
Ports 3.2 through 3.4 are connected to
pins 4 through 6 of the LCD, respectively.
Port-3 output buffers can sink/source four
TTL inputs.

A 12MHz crystal oscillator is connected
to X

TAL1 and XTAL2 pins for operation of the
microcontroller. A high pulse on RST pin
(pin 9) while the oscillator is running re-
sets the microcontroller. In this circuit, this
pin is connected to +Vcc through capaci-
tor C5 (10 µF, 16V). The external-access
enable pin (EA) is connected to +Vcc for
internal program executions. This pin also
receives the 12V programming-enable volt-
age (VPP) during flash programming when

Fig. 6: Solder-side PCB layout for temperature
indicator using AT8952

Fig. 7: Component layout for the PCB

TABLE I
DS1621 Command Set

Instruction Description Protocol

Read Temperature Reads last converted temperature value from Aah
temperature register.

Read Counter Reads value of count remaining from counter. A8h
Read Slope Reads value of the slope accumulator. A9h
Start Convert T Initiates temperature conversion. EEh
Stop Convert T Halts temperature conversion. 22h
Access TH Reads or writes high temperature limit value into A1h

TH register.
Access TL Reads or writes low temperature limit value into A2h

TL register.
Access Configuration Reads or writes configuration data to configuration ACh

register.
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12V programming is selected.

The program
The C-language program for
microcontroller AT89C52 is compiled us-
ing cross-compiler C51 Version 7.10 from
Keil Software. The demo version of this
compiler is available for free on the
Website ‘www.keil.com.’ It can compile
programs up to 2 kB only, which is suffi-
cient for writing most programs.

For testing the display, the program
Hello.c is given here. This program, when
loaded to AT89C52, displays “Hello! How
R U?” on the LCD. The Hello.c program has
nothing to do with temperature. It just
guarantees a perfect communication be-
tween the LCD and the microcontroller.
For temperature indication, the program
Temp52.c is used. The programs Hello.c
and Temp52.c, along with the hex files, are
given at the end of this article.

The communication interface between
the temperature sensor and the
microcontroller chip follows the I2C (Inter
Integrated Circuit) standard, which
is implemented in ‘C’ here. I2C is a
simple master/slave type interface.
Simplicity of the I²C system is primarily
due to the bidirectional 2-wire (SDA and
SCL) design and the protocol format.
Bidirectional communication is through 2-
wire lines (which are either active-low or
passive-high). In the program, the i2c_stop,
i2c_start, i2c_write and i2c_read functions
are used for communicating Clock and Data
from DS1621 to P3.0 and P3.1 of AT89C52,
respectively. Such functions as command,
ready and display in the program are used
for driving the LCD.

Program compilation for 8051 family
controller. Keil C51 can compile C pro-
grams for most of the Atmel family
microcontrollers. It also supports other de-
vices. Unlike other cross-compilers (Hi-
Tech, IAR, SDCC, etc), Keil C51 offers such
features as fast code generation, strong
multitasking environment, real-time oper-
ating system and inbuilt code optimisation.
To enjoy these features, you’ll need full
version of the compiler.

Keil C51 has options to generate As-
sembly code and all the code listing sup-
ported by 8051 family, but Assembly lan-
guage generated cannot be recompiled on
any other assembler. As far as code genera-
tion is concerned, it uses minimum RAM
and on-chip flash, allowing faster and
optimised program in Intel-Hex format,
which can be loaded to the microcontroller

using any programmer. Conversion of C
program into Intel-Hex format takes only a
few seconds. In fact, you don’t require all
that long Assembly program in order to
generate the output hex file.

LCD
For display, a Lampex make 16x1 LCD
(model GDM1601A) was used. Pin connec-
tions of this LCD are given in Table II. Pins
15 and 16 haven’t been used. Pin 3 is
connected to the circuit ground through a
1-kilo-ohm preset that is used to control
the light intensity of the LCD. Note that the
Hitachi make 16×1 LCD (HD44780A00)
will not work in this project.

Construction
The circuit of this temperature indicator
using microcontroller AT89C52 can be as-
sembled on any general-purpose, single-
side PCB. The microcontroller chip and
the temperature sensor chip are mounted
on the respective IC bases. Ensure a proper
contact between pins of the IC bases and
the solder points on the PCB. Capacitors
C3 and C4 must be connected near IC2
and IC3, respectively. The actual-size,
single-side PCB layout for the circuit and
its component layout are shown in Figs 6
and 7, respectively.

Program compilation
After you’ve installed Keil C51 in your
PC, you can compile C program and gen-
erate hex file in either DOS or Windows
mode. Here, program compilation for the

program Hello.c has been explained. The
same procedure is to be followed for the
temperature indication program
Temp52.c. For more example programs,
refer to the directory in your hard drive
where Keil is installed in the example
folder.

DOS mode. 1. Installation of Keil C51
automatically generates ‘Keil’ folder in
your computer’s C drive.

2. Go to ‘C:\Keil\C51\Bin’ folder in-
side ‘Keil’ folder.

3. Copy ‘Hello.c’ into ‘Bin’ folder.
4. Copy ‘Regx52.h’ from

‘C:\Keil\C51\Inc\Atmel’ folder into
‘C:\Keil\C51\Bin’ folder.

5. Type ‘c51 Hello.c’ against the
prompt and press Enter key.

6. Type ‘bl51 Hello.obj.’ This com-
mand is used for linking the Hello.obj
file created by Keil C51.

7. Type ‘oh51 Hello.’ This command
is used for creating the hex file.

Windows mode. 1. Installation of Keil
C51 software automatically creates the icon
‘Keil uVision2’ on the desktop.

2. Double-click ‘Keil uVision2.’
3. Suppose you have kept ‘Hello.c’ un-

der ‘C:\Windows\Desktop\Hello’ folder.
Open ‘Hello.c’ from the ‘File’ menu.

4. From the menu bar, select ‘Project/
New Project.’ Name the new project and
save it with extension ‘.uv2.’

5. Select CPU as Atmel/AT89C52.
6. Choose ‘Yes’ in the option “Copy

standard 8051 code to current project folder.”
7. Choose ‘View/Project Window.’ A

‘Project Workspace’ window appears.
8. Double-click ‘Target 1.’
9. Right-click ‘Source Group1’ and se-

lect “Add files to Group ‘Source Group1.’”
A window appears.

10. Add ‘Hello.c’ and close this window.
11. Double-click ‘Source Group1’ on

the ‘Project Workspace’ window. Now the
file name ‘Hello.c’ appears.

12. From ‘Project’ menu, select ‘Op-
tions for File ‘Hello.c.’ In ‘Properties,’
choose file type as ‘C source file.’

13. Again from ‘Project’ menu, select
‘Options for Target ‘Target1.’” A screen
appears.

14. Choose ‘Output’ and tick on ‘Hex
File’ for generating the hex file. Again
choose ‘Listing’ option and tick on ‘Con-
ditional and Assembly Code’.

15. Open the Project menu and select
‘Build Target’ or press F7. The compiler
shows “”Hello” 0 Error(s), 0 Warning(s)”
in the output window just below the
project window.

TABLE II
Pin Connections of the LCD

Pin No. Functions

Pin 1 Ground (Gnd)
Pin 2 +Vcc
Pin 3 V0 (display intensity control)
Pin 4 RS (connected to P3.2 of AT89C52)
Pin 5 R/W (connected to P3.3 of AT89C52)
Pin 6 EN (connected to P3.4 of AT89C52)
Pin 7 D0 (connected to P1.0 of AT89C52)
Pin 8 D1 (connected to P1.1 of AT89C52)
Pin 9 D2 (connected to P1.2 of AT89C52)
Pin 10 D3 (connected to P1.3 of AT89C52)
Pin 11 D4 (connected to P1.4 of AT89C52)
Pin 12 D5 (connected to P1.5 of AT89C52)
Pin 13 D6 (connected to P1.6 of AT89C52)
Pin 14 D7 (connected to P1.7 of AT89C52)
Pin 15 Backlight +Vcc (not used)
Pin 16 Backlight Gnd (not used)
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TEMP52.C
/* Written By: Aditya Rane
T.E Computer Engg, Lokmanya Tilak College of Engineer-

ing, New Bombay, Vashi
E-mail: aditya@orionengg.com
Program for temperature indicator compiled under keil

'C' */

#include<stdio.h>
#include<string.h>
#include<Regx52.h>

//------------------------------------------------------------------------
//Global Variable
//-------------------------------------------------------------------------
int temperature;
#define HIGH 0x01 // Active High Signal
#define LOW 0x00 // Active Low Signal
#define TRUE 0x01 // Active High State
#define FALSE 0x00 // Active Low State

//-------------------------------------------------------------------------
// Functions Prototyping
//-------------------------------------------------------------------------
void ready (void);
void command (int);
void display (char *);
void i2c_stop (void);
void i2c_start (void);
void i2c_write (unsigned char);
unsigned char i2c_read (void);
void convert (unsigned char);

//-------------------------------------------------------------------------
// Port Defination
//-------------------------------------------------------------------------
#define DATA P3_1 // Serial data
#define CLOCK P3_0 // Serial clock

//Begining of Main Program
void main (void)
{
int tmp;
char str[16];
bit flag = FALSE;
unsigned char ch;
void command (int);
void display (char *);
command(0x3c);
command(0x0c);
command(0x06);
while(1)
{

i2c_start();
i2c_write(0x90);
i2c_write(0xEE);
i2c_stop();

i2c_start();
i2c_write(0x90);
i2c_write(0xAA);
i2c_start();
i2c_write(0x91);
ch = i2c_read();
i2c_stop();
temperature = 0;
convert(ch);
if(flag == FALSE)
{

flag = TRUE;

tmp = temperature;
}
else
{

if(tmp != temperature)
{

tmp = temperature;

sprintf(str,"%d%s",temperature," Centigrade");
command(0x01);
command(0x80);
display(str);

}
}

}
}

//Delay Servive Routine
void delay_time (void)
{
unsigned int i;
for(i=0;i<100;i++);
}

//I2C Start Function
void i2c_start (void)
{
DATA = HIGH;
delay_time();
CLOCK = HIGH;
delay_time();
DATA = LOW;
CLOCK = LOW;
}

//I2C Stop Function
void i2c_stop (void)
{
unsigned char i;
CLOCK = LOW;
DATA = LOW;
CLOCK = HIGH;
delay_time();
DATA = HIGH;
i = DATA;
}

//I2C Data Write Function
void i2c_write (unsigned char j)
{
unsigned char i;
for(i=0;i<8;i++)
{

DATA = ((j & 0x80) ? 1 : 0);
j <<= 1;
CLOCK = HIGH;
delay_time();
CLOCK = LOW;

}
i = DATA;
CLOCK = HIGH;
delay_time();
CLOCK = LOW;

}

//I2C Data Read Function
unsigned char i2c_read (void)
{
unsigned char i,j;
j = 0;
i = DATA;
for(i=0;i<8;i++)
{

j <<= 1;
CLOCK = HIGH;
j |= DATA;
delay_time();
CLOCK = LOW;

}

return j;
}

//Binary to Decimal Conversion Function
void convert (unsigned char ch)
{
char x;
unsigned char arr[8]={128,64,32,16,8,4,2,1};
if(((ch & 0x80) ? 1 : 0)==0)
{

for(x=0;x<8;++x)
{

if(((ch & 0x80) ? 1 : 0))
temperature = temperature +

arr[x] * ((ch & 0x80) ? 1 : 0);
ch <<= 1;

}
}
else
{

ch=~ch;
ch=ch+1;
for(x=0;x<8;++x)
{

if(((ch & 0x80) ? 1 : 0))
temperature = temperature +

arr[x] * ((ch & 0x80) ? 1 : 0);
ch <<= 1;

}
temperature=-temperature;

}
}

//Display Ready Check Function
void ready (void)
{
P3_4 = 0x00;
P1 = 0xff;
P3_2 = 0x00;
P3_3 = 0x01;
while(P1_7)
{

P3_4 = 0x00;
P3_4 = 0x01;

}
P3_4 = 0x00;
}

//Display Command Function void command (int a)
{
ready();
P1 = a;
P3_2 = 0x00;
P3_3 = 0x00;
P3_4 = 0x01;
P3_4 = 0x00;
}

//Display Write Function
void display (char *str)
{
unsigned int i;
for(i=0;i<=strlen(str)-1;++i)
{

if(i == 8)
command(0xc0);
if(i == 16)
command(0x80);
ready();
P1 = str[i];
P3_2 = 0x01;
P3_3 = 0x00;
P3_4 = 0x01;
P3_4 = 0x00;

}
}

16. Close the screen and go to the
‘Hello’ folder to see the generated hex file
and listing file.

Load the hex file into the
microcontroller chip using a programmer.
(Here’ we’ve used Atmel Flash Program-
mer from Frontline Electronics.) Now in-
tegrate the microcontroller chip into the
populated PCB comprising the tempera-
ture sensor and the LCD module.

Troubleshooting
1. Check the COM port on your PC before
programming.

2. In case there is no message even if
all the connections are correct, adjust the
intensity control potentiometer (VR1) for
display.

3. Check whether your hex file
matches with the hex file given below in

the article.
4. If the LCD shows wrong characters,

replace it with another make LCD.
5. If DS1621 is not connected prop-

erly to AT89C52, the display will be com-
pletely blank.

EFY Lab note. All the source
codes and relevant files of this article
have been included in this month’s
EFY-CD.
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HELLO.C
#include<stdio.h>
#include<string.h>
#include<Regx52.h>

void ready(void);
void command(int);
void display(char *);
void main (void)
{
command(0x3c);
command(0x0c);
command(0x06);
command(0x01);
command(0x80);
display("Hello! How R U ?");
while(1);
}

void command(int a)
{

void ready(void);
ready();
P1=a;
P3_2=0x00;
P3_3=0x00;
P3_4=0x01;
P3_4=0x00;
}

void display(char *str)
{
unsigned int i;
for(i=0;i<=strlen(str)-1;++i)
{

if(i == 8)
command(0xc0);
if(i == 16)
command(0x80);
ready();
P1 = str[i];

P3_2 = 0x01;
P3_3 = 0x00;
P3_4 = 0x01;
P3_4 = 0x00;

}
}

void ready(void)
{
P3_4=0x00;
P1=0xff;
P3_2=0x00;
P3_3=0x01;
while(P1_7)
{

P3_4=0x00;
P3_4=0x01;

}
P3_4=0x00;
}

HELLO.HEX
:0300000002092AC8
:0C092A00787FE4F6D8FD75810E0208AE5F
:1009190048656C6C6F2120486F7720522055203F25
:0109290000CD
:1008AE007F3C7E001209067F0C7E001209067F0631
:1008BE007E001209067F017E001209067F807E00EF
:0E08CE001209067BFF7A09791912080080FED4
:100906008E0D8F0E1208DC850E90C2B2C2B3D2B421
:03091600C2B42246
:060800008B088A09890A39

:10080600E4F50BF50CAB08AA09A90A1208F1EF24C6
:10081600FFFFEE34FFFED3E50C9FE50B9E5042E54D
:100826000C6408450B70067FC0FE120906E50C64D1
:1008360010450B70067F80FE1209061208DCAB0815
:10084600AA09A90A850C82850B83120868F590D23D
:10085600B2C2B3D2B4C2B4050CE50C70A8050B80C5
:01086600A4ED
:01086700226E
:1008DC00C2B47590FFC2B2D2B3309706C2B4D2B4D0
:0508EC0080F7C2B422F8

:10086800BB010CE58229F582E5833AF583E0225045
:1008780006E92582F8E622BBFE06E92582F8E2228F
:0D088800E58229F582E5833AF583E49322A9
:1008F100E4FFFE120895600C0FEF70010E09E9701C
:05090100F20A80EF2264
:10089500BB010689828A83E0225002E722BBFE0261
:0908A500E32289828A83E4932294
:00000001FF

❑

TEMP52.HEX
:100F270025642573002043656E7469677261646583
:090F3700008040201008040201B2
:100DA800C2007F3C7E00120F9A7F0C7E00120F9AC1
:100DB8007F067E00120F9A120F8B7F90120EB87F5B
:100DC800EE120EB8120F6A120F8B7F90120EB87FB8
:100DD800AA120EB8120F8B7F91120EB8120F098F3C
:100DE80034120F6AE4F508F509AF34120CF220004A
:100DF8000AD20085082285092380BCE5236509708D
:100E080004E522650860B08508228509237538FF46
:100E180075390F753A2785083B85093C753DFF757F
:100E28003E0F753F2C7B007A00792412085C7F0105
:100E38007E00120F9A7F807E00120F9A7B007A0044
:080E48007924120E50020DBFC7
:0E0F7C00E4FFFE0FBF00010EEF64644E70F53F
:010F8A002244
:0F0F8B00D2B1120F7CD2B0120F7CC2B1C2B02211
:100F6A00C2B0C2B1D2B0120F7CD2B1A2B1E433F591
:010F7A003541
:010F7B002253
:020EB800AD0784
:100EBA00E4FCED30E703D38001C392B1ED25E0FDF8
:100ECA00D2B0120F7CC2B00CBC08E7A2B1E433FC6A
:070EDA00D2B0120F7CC2B080
:010EE10022EE
:100F0900E4FDA2B1E4FCED25E0FDD2B0A2B1E433E9
:0D0F19004205120F7CC2B00CBC08EBAF0506
:010F260022A8
:020CF2008F353C
:100CF40078377C007D007BFF7A0F79387E007F088F
:100D0400120C2CE53530E7047F0180027F00EF7080
:100D140041F536E53530E7047F0180027F00EF605E
:100D24002374372536F8E6FD7C00E5357E0030E790
:100D3400047F0180027F00120C7FEF2509F509EE84
:100D44003508F508E53525E0F5350536E536B4080A
:100D5400C2226335FF0535E4F536E53530E7047F17
:100D64000180027F00EF602374372536F8E6FD7CAE
:100D740000E5357E0030E7047F0180027F00120C1D
:100D84007FEF2509F509EE3508F508E53525E0F589
:100D9400350536E536B408C2C3E49509F509E4958A
:030DA40008F50847
:010DA7002229
:100F4000C2B47590FFC2B2D2B3309706C2B4D2B465
:050F500080F7C2B4228D
:0E0F9A00120F408F90C2B2C2B3D2B4C2B422C2
:060E50008B358A3689375C
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